
Configuração do Cluster Microsoft usando o Windows 2003 Server 

 São Paulo, 21 de Março de 2011 

Todos os direitos autorais que vão à merda. 

 

  

 

 
 
 

 
 
 
 
 
 

Preparado por: 
 
Ditador Nicastro 
Analista de Segurança 
Corporações Nicastro c.o. 

Versão 1.0

 

 

 

 

CONFIGURAÇÃO DO 

CLUSTER MICROSOFT 

USANDO O WINDOWS 2003 

SERVER 

 

 
 
 
 
 
RELATÓRIO DE INSTALAÇÃO E CONFIGURAÇÃO DE 

CLUSTERS. 
 
 
 
 
 
 
 

 

 
 

 

Este documento é o relatório do resultado do trabalho realizado nas 

Corporações Nicastro c.o. 

PROJETO  DE  REDES 
www.projetoderedes.com.br



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

2 

DN c.o. 
Avenida da verdade sem número 

Nicastro Island 

1. Índice 

 

1. ÍNDICE .............................................................................................. 2 

2. COMO FUNCIONA O CLUSTER .................................................................... 3 

2.1 Pré-requisitos ........................................................................................................ 4 

 
3. INICIANDO A CONFIGURAÇÃO ................................................................... 6 

3.1 Instalando o serviço de DNS ............................................................................. 6 
3.2 Instalando o serviço de DHCP ......................................................................... 18 
3.3 Instalando o serviço WINS ............................................................................... 28 
3.4 Configurando as placas de rede ...................................................................... 35 
3.5 Conectando membros ao DNS ........................................................................ 43 

 

4. Configuração do Cluster  ................................................................................. 47 
 

4.1 Criando o usuário de controle do cluster  .............................................. 47 
4.2 Instalação do primeiro nó  ................................................................ 52 

4.3 Adicionando outro nó ao cluster  ........................................................ 61 

 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

3 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

 

2. Como Funciona o Cluster 

 

Um cluster de servidor é um grupo de servidores independentes trabalhando de forma 

coletiva e executando o MSCS (Microsoft Cluster Service). Os clusters de servidor 

fornecem alta disponibilidade, failback, escalabilidade e capacidade de gerenciamento 
para recursos e aplicativos.  

Os clusters de servidor permitem que os clientes acessem os aplicativos e os recursos 

no caso de falhas e interrupções planejadas. Se um dos servidores no cluster não 

estiver disponível devido a uma falha ou aos requisitos de manutenção, os recursos e 
os aplicativos serão movidos para outros nós de cluster disponíveis. 

Nas soluções do Windows Clustering, o termo ―alta disponibilidade‖ é usado no lugar 

de "tolerância a falhas‖. A tecnologia tolerante a falhas oferece um nível mais alto de 

flexibilidade e recuperação. Os servidores tolerantes a falhas normalmente usam um 

alto grau de redundância de hardware, além de software especializado, para fornecer 

uma recuperação quase instantânea de qualquer falha de hardware ou software. 

Essas soluções custam mais que as soluções do Windows Clustering, pois as 

organizações devem pagar pelo hardware redundante que aguarda, em um estado 
ocioso, uma falha.  

Os clusters de servidor não garantem uma operação sem interrupções, mas eles 

fornecem disponibilidade suficiente para a maioria dos aplicativos de missão crítica. O 

serviço de cluster pode monitorar os aplicativos e os recursos, reconhecer-se e 

recuperar-se automaticamente de muitas condições de falha. Isso fornece flexibilidade 

no gerenciamento da carga de trabalho em um cluster. Ele também aperfeiçoa a 
disponibilidade geral do sistema. 

Os benefícios do serviço de cluster incluem: 

 Alta disponibilidade: com os clusters de servidor, a propriedade dos 

recursos, como unidades de disco e endereços IP, é automaticamente 

transferida de um servidor com falhas para um servidor disponível. Quando há 

uma falha em um sistema ou em um aplicativo no cluster, o software do 

cluster reinicia o aplicativo com falha em um servidor disponível ou distribui o 

trabalho do nó com falha para os nós restantes. Conseqüentemente, o usuário 

terá apenas uma pausa momentânea no serviço.  

 Failback: o serviço de cluster atribuirá novamente, de forma automática, a 

carga de trabalho em um cluster quando um servidor com falha estiver online 

para seu proprietário pré-determinado preferencial. Esse recurso pode ser 

configurado, mas está desativado por padrão.  

 Capacidade de gerenciamento: é possível usar a ferramenta Administrador 

de Cluster (CluAdmin.exe) para gerenciar um cluster, como um único sistema, 

e os aplicativos como se estivessem em execução em um único servidor. Você 

pode mover os aplicativos para servidores diferentes no cluster. O 

Administrador de cluster pode ser usado para equilibrar as cargas de trabalho 

do servidor manualmente e liberar os servidores para a manutenção planejada. 

É possível também monitorar o status do cluster, todos os nós e os recursos de 

qualquer lugar na rede.  

 Escalabilidade: os serviços de cluster podem aumentar para atender à 

crescente demanda. Quando a carga total para um aplicativo com 
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reconhecimento de cluster excede os recursos do cluster, os nós adicionais 
podem ser incluídos.  

 

2.1 Pré-Requisitos. 

Requisitos de software 

 Microsoft Windows Server 2003 Enterprise Edition ou Windows Server 2003 

Datacenter Edition instalado em todos os computadores no cluster.  

 Um método de resolução de nome, como DNS (Domain Name System - 

Sistema de nomes de domínio), protocolo de atualização dinâmica de DNS, 

WINS (Windows Internet Name Service), HOSTS dentre outros.  

 Um modelo de domínio existente.  

 Todos os nós devem ser membros do mesmo domínio.  

 Uma conta no nível de domínio que seja um membro do grupo de 
administradores locais em cada nó. Uma conta dedicada é recomendada. 

Requisitos de hardware 

 O hardware de cluster deve estar na HCL (Hardware Compatibility List - Lista 

de compatibilidade de hardware) do serviço de cluster. Para localizar a versão 

mais recente da HCL do serviço de cluster, vá para a Lista de compatibilidade 

de hardware do Windows em 

http://www.microsoft.com/whdc/hcl/default.mspx (site em inglês) e procure 

por cluster. A solução completa deve ser certificada na HCL, não apenas os 

componentes individuais. Para obter informações adicionais, consulte o 
seguinte artigo no Microsoft Knowledge Base: 

309395(site em inglês) The Microsoft Support Policy for Server Clusters and 
the Hardware  

Observação   Se você estiver instalando esse cluster em uma 

SAN (Storage Area Network - rede local de armazenamento) e 

planeja ter vários dispositivos e clusters compartilhados na SAN 

com um cluster, a solução também deverá estar na Lista de 

compatibilidade de hardware ―Cluster/Multi-Cluster Device‖. Para 

obter informações adicionais, consulte o seguinte artigo no 

Microsoft Knowledge Base: 

304415(site em inglês) Support for Multiple Clusters Attached to the Same 

SAN Device  

  

 Dois adaptadores de rede de PCI em cada nó no cluster.  

 Cabos de armazenamento para conectar o dispositivo de armazenamento 

compartilhado em todos os computadores. Consulte as instruções do fabricante 

para configurar os dispositivos de armazenamento. Consulte o apêndice que 

http://www.microsoft.com/whdc/hcl/default.mspx
http://support.microsoft.com/default.aspx?scid=kb;en-us;309395&sd=tech
http://support.microsoft.com/default.aspx?scid=kb;en-us;304415&sd=tech
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acompanha esse artigo para obter informações adicionais sobre a configuração 

específica necessária ao usar SCSI ou Canal de fibra.  

 Todos os hardwares devem ser idênticos, slot a slot, placa a placa, BIOS e 

revisões de firmware etc, para todos os nós. Isso torna a configuração mais 
fácil e elimina os problemas de compatibilidade.  

Requisitos de rede 

 Um nome NetBIOS exclusivo.  

 Endereços IP estáticos para todas as interfaces de rede em cada nó.  

Observação   O Cluster de servidor não fornece suporte para o 

uso de endereços IP atribuídos a partir de servidores DHCP 

(Dynamic Host Configuration Protocol - Protocolo de 

configuração dinâmica de hosts).  

 Acesso a um controlador de domínio. Se o serviço de cluster não puder 

autenticar a conta do usuário para iniciar o serviço, poderá haver uma falha no 

cluster. É recomendado que você tenha um controlador de domínio na mesma 

LAN do cluster para assegurar a disponibilidade.  

 Cada nó deve ter no mínimo dois adaptadores de rede — um para conexões 

com a rede pública de clientes e outra para a rede privada de cluster nó a nó. 

Um adaptador de rede privada dedicado é necessário para a certificação da 

HCL.  

 Todos os nós devem ter duas LANs fisicamente independentes ou LANs virtuais 

para comunicações públicas e particulares.  

 Se você estiver usando placas de rede tolerantes a falhas ou um conjunto de 

adaptadores de rede, certifique-se de estar usando o firmware e os drivers 

mais recentes. Consulte o fabricante do adaptador de rede para obter 
informações sobre compatibilidade de cluster. 
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3. Iniciando A Configuração 

 

3.1 Instalando o serviço de DNS 

O DNS (sistema de nomes de domínio) do Microsoft® Windows 2003 fornece uma 

resolução de nomes eficiente, suporte a serviços de diretório do Active Directory™ e 

interoperabilidade com outras tecnologias baseadas em padrão. A implantação de 

DNS em sua infra-estrutura cliente/servidor ativa recursos em uma rede TCP/IP para 

localizar outros recursos na rede, usando resolução de nomes de host para endereço 
IP e de endereço IP para nome de host.  

 

 

 

 

 

Vá em Start -> Administrative tools -> Configure Your Server Wizard. 
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Abrirá a tela de apresentação do assistente, clique em Next >. 

 

 
Uma tela com algumas recomendações aparecerá, clique em Next >. 
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O assistente fará uma detecção das placas de rede e dos serviços que estão rodando no 
momento. 

 

 
Nesta tela escolha a opção ―Custom Configuration‖ e clique em Next >. 
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Na tela de regras de servidor, escolha a opção Domain Controler (Active Directory) – 

Controlador de domínio – e clique em Next >. 

 

 
Uma tela de resumo das operações será exibida, apenas clique em Next >. 
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A tela de instalação do active directory aparecerá, clique em Next >. 

 

 
Uma tela de compatibilidade do sistema será mostrada, apenas clique em Next >. 
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Na tela de tipo de controlador de domínio escolha a opção ―Domain controller for a new 
domain‖ e clique em Next >. 

 

 
Nesta tela deixa a opção ―Domain in a new forest‖ selecionada e clique em Next >. 
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Escolha um nome para seu domínio, no caso pode ser o mesmo que no exemplo, e clique em 
Next >. 

 

 
Deixe o nome sugerido pelo assistente para NetBIOS e clique em Next >. 
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Deixe as pastas default para o banco de dados e para os logs, clique em Next >. 
 

 
 
Aqui também deixe a pasta default, clique em Next >. 
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Uma tela de ―Diagnostic Failed‖ aparecerá, isto é normal se esta é a primeira vez que você 
instala o Active Directory, selecione ―Install and configure DNS server...‖ e clique em Next >. 

 

 
Na tela de permissões não mude nada, apenas clique em Next >. 
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Digite uma senha confirme e clique em Next >. 
 

 
 
Nesta tela de resumo da instalação apenas clique em Next >. 

 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

16 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

 
 

Aguarde enquanto a instalação é concluída. 
 

 
 

Durante a instalação do DNS o cd de instalação do windows 2003 será pedido, insira 

no drive e clique em OK. 
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Pronto, a instalação foi concluída com êxito, ao clicar em Finish seu computador será 
reinicializado. 

 

 
 
Clique em Restart Now para que as novas instalações tenham efeito. 
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3.2 Instalando o serviço de DHCP 

Um servidor DHCP nada mais é do que um servidor que possui o serviço DHCP 

instalado e configurado para responder a solicitações de computadores clientes por 

endereços IP em nossa rede. Ou seja, quando um cliente for inicializado e não tive 

rum endereço IP configurado, ele manda uma mensagem para toda a rede em busca 

de um endereço IP. Todos os computadores receberão essa mensagem, porém o 

único que poderá atender a ela é o servidor DHCP. 

 

 

 

Novamente vá em Start -> Administrative Tools -> Configure Your Server Wizard 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

19 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

 
 
Na tela de apresentação do assistente clique em Next >. 

 

 
 

Nesta tela basta clicar em Next >. (Já passamos por ela anteriormente). 
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Mais uma vez o assistente fará uma busca pelos componentes de rede e serviços instalados. 
 

 
 
Desta vez em regras do servidor escolheremos a opção ―DHCP server‖, note que agora as 
opções ―Domain Controler‖ e ―DNS server‖ estão marcadas com um ―Yes‖ na aba ―Configured‖, 
clique em Next >. 
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Na tela de resumo da instalação clique em Next >. 
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A instalação irá iniciar imediatamente. 
 

 
 

Mais uma vez o cd de instalação do windows 2003 é pedido, insira-o e clique em OK. 
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Após a instalação a tela do assistente de novo escopo será exibida, clique em Next >. 
 

 
 

Dê um nome ao novo escopo, a descrição não é necessária, e clique em Next >. 
 

 
 

Digite o endereço de ip inicial e final do escopo, e clique em Next >. 
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Obs.: Aqui usei apenas dois nós no cluster sendo o ip 192.168.30.11 o primeiro, 192.168.30.12 
o segundo e o ip 192.168.30.13 como ip do serviço de cluster, dependendo da configuração de 
sua rede isto irá mudar. 

 

 
 
Aqui dever ser indicado o ip ou limite de ips que serão excluídos do dhcp, clique em Next >. 
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Aqui você indica o tempo em que os clientes podem usar um endereço de ip do escopo, não é 
preciso alterar nada apenas clique em Next >. 

 

 
 
Deixe a opção para configurar as opções do dhcp ativa e clique em Next >. 
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Na tela de configuração de roteador digite o endereço de ip do mesmo e clique em Next >. 
 

 
 

Informe o domínio e o ip do DNS e clique em Next >. 
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Informe o ip do servidor WINS e clique em Next >. 
 

 
 

Deixe a opção para ativar o escopo agora selecionada e clique em Next >. 
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Pronto a configuração do DHCP está concluída basta clicar em Finish. 
 

3.3 Instalando o serviço WINS 

Os servidores WINS (Serviço de Cadastramento na Internet do Windows) mapeiam 

dinamicamente endereços IP para nomes de computador (nomes NetBIOS). Isso permite que 
os usuários acessem recursos usando o nome do computador, em vez do endereço IP. 
 

 
 

 

Vá em Start -> Administrative Tools -> Configure Your Server Wizard. 
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Na tela de apresentação do assistente clique em Next >. 
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Nesta tela clique em Next >. 
 

 
 

Na tela de regras do servidor escolha a opção ―WINS server‖ e clique em Next >. 
 

 
 

Na tela de resumo das seleções basta clicar em Next >. 
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Insira o cd do windows 2003 no drive e aguarde enquanto a instalação é concluída. 

 

 
 
Pronto basta clicar em Finish e a instalação está completa. 
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Vá em Start -> Administrative Tools -> DNS 
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Expanda a pasta ―Forward Lookup Zones‖ e depois a ―clusterzone.com.br‖. 
 

 
 

Dê um duplo clique no documento ―Name Server(NS)‖. 
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Vá na aba WINS ative a opção ―Use WINS forward lookup‖ adicione o endereço de ip do 

servidor WINS, depois clique em ―Aplpy‖ e em seguida em ―OK‖. 

 

 
 
Agora feche o assistente do DNS. 

 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

35 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

3.4 Configurando as placas de rede 

 
Agora vamos configurar as placas de rede, lembrando que precisamos no mínimo de 2(duas) 
placas de redes, neste exemplo usamos duas placas em cada nó(computador). 

 

 
 
Vá em Start -> Acessories -> Communications -> Network Connections 
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Clique com o botão direito do mouse sobre a primeira placa de rede e clique em ―Rename‖ e 
mude o nome para Privado. 
 

 
 

Clique novamente com o botão direito e clique em ―Properties‖. 
 
 
 
 

 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

37 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

 
 
Retire a seleção das opções ―Client for Microsoft Networls‖ e ―File and Printer Sharing...‖, 
selecione a opção ―Internet Protocol(TCP/IP) e clique em ―Properties‖. 

 

 
 
Digite um ip de classe ―A‖ e a máscara, não digite gateway nem dns para esta placa, clique em 

―Advanced...‖ 
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Na aba DNS retire as opções ―Append parent suffixes of the primary DNS suffix‖ e ―Register this 
connection’s addresses in DNS‖ vá para a aba WINS. 

 

 
 
Retire a opção ―Enable LMHOSTS lookup‖ e em ―NetBIOS setting‖ selecione ―Disable NetBIOS 

over TCP/IP‖ clique em ―OK‖ e depois em ―OK‖ novamente. 
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Eventualmente você vai receber esta mensagem dizendo que nenhum servidor de DNS foi 

configurado nesta placa, apenas clique em ―OK‖. 
 

 
 

Feche as propriedades da conexão clicando em ―Close‖, repita os passos em todos os outros 
nós (computadores) que farão parte do cluster, lembrando de usar um ip classe ―A‖ e não usar 
um que já foi configurado, esta rede será de comunicação interna entre os nós. 
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Na outra placa clique com o botão direito e clique em ―Rename‖, mude o nome da conexão para 
Publico. 
 

 
 

Clique novamente com o botão direito do mouse e clique em ―Properties‖. 
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Na tela de propriedades selecione a opção ―Internet Protocol (TCP/IP)‖ e clique em ―Properties‖. 
 

 
 
Digite um endereço de ip dentro do escopo do dhcp que criamos, digite a máscara e se sua 
rede possuir digite o gateway, abaixo digite o endereço do DNS que criamos, se sua rede 
possuir mais de um DNS você pode especificar um secundário, clique em ―OK‖. 
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Agora basta clicar em ―Close‖ para finalizar a configuração das placas. 
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3.5 Conectando membros ao DNS 

Agora vamos conectar os computadores que farão parte do cluster no domínio. 

 

 

Vá em Start clique com o botão direito do mouse no ícone ―My Computer‖ e clique em 

―Properties‖. 
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Clique na aba ―Computer Name‖ e clique no botão ―Change...‖ 

 

 
 
Em ―Member of‖ ative a opção ―Domain‖ digite o nome do domínio e clique em ―OK‖. 
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Será pedido um usuário e senha do domínio, no nosso exemplo usamos o usuário Administrator 

do computador mesmo, clique em ―OK‖. 
 

 
 

Uma tela de boas vindas aparecerá, clique em ―OK‖. 
 

 
 

Então o computador pedirá para ser reiniciado para que as mudanças tenham efeito, clique em 

―OK‖. 
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Clique em ―OK‖ para fechar as propriedades do computador. 

 
 
 

 
 
E finalmente clique em ―Yes‖ quando perguntado se você deseja reiniciar o computador. 

Pronto nosso primeiro nó já faz parte do domínio que criamos, repita estes passos em todos os 
outros restantes. 
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4. Configuração do Cluster 

 
 

4.1 Criando usuário de controle do cluster 

 

 

 
 
Vá em Start -> Administrative Tools -> Active Directory Users and Computers 
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Aberto o Active clique com o botão direito na pasta Users -> New -> User. 

 

 
 
Digite um nome para o usuário, pode ser cluster mesmo, e clique em Next >. 
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Digite uma senha, retire a seleção da opção ―User must change password at next logon‖ e 
habilite as opções ―User cannot change password‖ e ―Password never expires‖ e clique em Next. 
 

 
 

Clique em Finish para finalizarmos esta parte. 
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De volta à tela do Active clique com o botão direito no usuário que criamos e clique em 
―Properties‖. 
 

 
 
Vá na aba ―Member Of‖ e clique em ―Add...‖. 
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Na tela de grupos digite ―Administrator‖ e clique em ―OK‖. 
 

 
 
Clique em ―Apply‖ e depois em ―OK‖, em seguida feche o Active. 
Pronto já criamos o usuário que vai controlar nosso cluster, vamos a instalação. 
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4.2 Instalação do primeiro nó 

 

 
 
Vá em start -> Administrative Tools -> Cluster Administrator 
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Na tela do administrador selecione na caixa de diálogos a opção ―Create new cluster‖ e clique 
em ―OK‖. 
 

 
 
Na tela de apresentação do assistente clique em Next >. 
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Selecione o domínio e crie um nome para o cluster, depois clique em Next >. 
 

 
 
Digite o nome do computador que será o primeiro nó do cluster e clique em Advanced. 
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Nas opções avançadas selecione ―Advanced (minimum) configuration‖, clique em ―OK‖ e depois 
clique em Next >. 

 

 
 
O analisador irá verificar as configurações para que continuemos com a instalação. 
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Após a análise feita clique em Next >. 
 

 
 
Digite o endereço de ip que reservamos no DHCP para o cluster e clique em Next >. 
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Digite o usuário de controle que criemos e a senha, clique em Next >. 
 

 
 
Na tela de resumo das configurações clique em ―Quorum...‖. 
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E troque a opção de ―Local Quorum‖ para ―Majority Node Set‖, clique em ―OK‖ e depois em 
Next >. 

 

 
 
O cluster será criado, aguarde. 
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Ao final clique em Next > ... 
 

 
 
... e então em Finish. 
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Quando você clicar em Finish no final da instalação, voltará à tela do Administrador do cluster, 

com o novo nó já conectado ao serviço. 
Pronto agora só falta adicionar os outros nós e depois os serviços que farão parte do nosso 
novo cluster. 
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4.3 Adicionando outro nó ao cluster 

 
Agora iremos adicionar outro nó (computador) ao serviço de cluster criado. 
 

 
 

 
Vá em Start -> Administrative Tools -> Cluster Administrator 
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Abrirá a tela do administrador já com o primeiro nó conectado. 
 

 
 
Clique em File -> New -> Node. 
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Na tela de apresentação basta clicar em Next >. 
 

 
 
Digite o nome do computador clique em ―Add‖, se for adicionar mais basta digitar o nome do 
seguinte e clicar em ―Add‖, depois clique em Next >. 



 DN c.o. 

Configuração do Cluster Microsoft usando o Windows 2003 Server 

64 

DN c.o. 

Avenida da verdade sem número 
Nicastro Island 

 
 
Aguarde enquanto o assistente analisa a configuração. 
 

 
 
Ao final da análise clique em Next >. 
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Digite a senha do usuário de controle do cluster que criamos e clique em Next >. 
 

 
 
Nesta tela basta clicar em Next >. 
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Aguarde enquanto as configurações são feitas. 
 

 
Aqui apenas clique em Next >. 
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E então clique em Finish para terminarmos o processo. 
 

 
 
Pronto, como você pode ver o segundo nó foi adicionado ao cluster. 
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Agora expanda a pasta ―Cluster Configuration‖ e depois ―Networks‖, clique com o botão direito 
sobre a conexão Privado e clique em ―Properties‖. 
 

 
 
Selecione a opção ―Internal cluster communications only‖ (private network), clique em ―Apply‖ 
e depois em ―OK‖. 
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Agora clique com o botão direito do mouse sobre Publico e clique em ―Properties‖. 
 

 
Selecione a opção ―Client Access only(public network)‖ clique em ―Apply‖ e depois em ―OK‖. 


